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Final Project 

Required Paper Format 

First A. Author1   
Business or Academic Affiliation’s Full Name 1, City, State, Zip Code, Country 

Abstract (approximately 200 words) 

These instructions give you guidelines for preparing papers for AIAA Technical 
Journals. Use this document as a template if you are using Microsoft Word 2001 or later for 
Windows, or Word X or later for Mac OS X. Otherwise, use this document as an instruction 
set. If you previously prepared an AIAA Conference Paper using the Papers Template, you 
may submit using the Papers Template so long as the text is double-spaced.  Carefully follow 
the journal paper submission process in Sec. II of this document. Keep in mind that the 
electronic file you submit will be formatted further at AIAA. This first paragraph is 
formatted in the abstract style. Abstracts are required for regular, full-length papers and 
express articles. Be sure to define all symbols used in the abstract, and do not cite references 
in this section. The footnote on the first page should list the Job Title and AIAA Member 
Grade (if applicable) for each author. 

Nomenclature (example) 

Papers with many symbols may benefit from a nomenclature list that defines all symbols with units, inserted 
between the abstract and the introduction. If one is used, it must contain all the symbology used in the manuscript, 
and the definitions should not be repeated in the text. In all cases, identify the symbols used if they are not widely 
recognized in the profession. Define acronyms in the text, not in the nomenclature.  
Cp = pressure coefficient 
Cx = force coefficient in the x direction 
Cy = force coefficient in the y direction 
c = chord, cm 
dt = time step, s 
Fx = X component of the resultant pressure force acting on the vehicle, N 
Fy = Y component of the resultant pressure force acting on the vehicle, N 
a = angle of attack, deg 
Θ = boundary-layer momentum thickness 
ρ = density, g/cm3 
 
Subscripts 
cg  = center of gravity 
G  = generator body 
iso  = waypoint index 

                                                             
1 Insert Academic Level, Department Name, and A number. 
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I. Introduction 

HIS document is a template for Microsoft Word 2001 or later. The default font for the Template is Times New 
Roman, 10-point size. In the electronic template, use the “Text” style from the pull-down menu to format all 
primary text for your manuscript. The first line of every paragraph should be indented, and all lines should be 
double-spaced. Default margins are 1 in. on all sides. In the electronic version of this template, all margins and 

other formatting are preset. There should be no additional (blank) lines between paragraphs.2 

II. Analysis 

Enter Description of Analytical methods, and derivations here. 

A. Oblique Shock Methods 
B. Prandtl-Meyer Methods 
C. Calculating CL, CD, L/D for Inviscid Flow 
D. Incompressible Skin Friction Models 

• Laminar 
• Transitional 
• Turbulent  

E. Skin Friction Compressibility Corrections  
• Laminar Flow Derivation 
• 1/7th Power Law (Turbulent) Correction 
• General (1/n) Power Law Correction 

Equations are numbered consecutively, with equation numbers in parentheses flush right, as in Eq. (1). Insert a 
blank line both above and below the equation. First use the equation editor to create the equation. If you are using 
Microsoft Word, use either the Microsoft Equation Editor or the MathType add-on (http://www.mathtype.com) for 
equations in your paper, use the function (Insert>Object>Create New>Microsoft Equation or MathType Equation) 
to insert it into the document. Please note that “Float over text” should not be selected. To insert the equation into 
the document, do the following: 

1) Select the “Equation” style from the pull-down formatting menu, and hit “tab” once. 
2) Insert the equation, and hit “tab” again. 
3) Enter the equation number in parentheses. 

 A sample equation is included here, formatted using the preceding instructions: 

  (1) 
Be sure that symbols in your equation are defined in the Nomenclature or immediately following the equation. 

Also define abbreviations and acronyms the first time they are used in the main text. (Very common abbreviations 
such as AIAA and NASA, do not have to be defined.) 

III. Results and Discussion 

Present all plots and numerical calculations here. Be sure to follow proper format for figures. Including scales, 
axis units, and figure labels.  

                                                             
2 NOTE: If you are using the Template to format your manuscript, the required spacing and formatting will be 

applied automatically, simply by using the appropriate style designation from the pull-down menu. Italics may be 
lost when you copy your text into the template.  
 

0
r2 F(r,ϕ) dr dϕ= [σr2∫ / (2µo )] 0

∞∫ exp(-λ|z j− zi |)λ
−1J1(λr2 )J0(λri dλ)

T 
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F. Required Project Elements 

• Proper Writeup Format All Required Elements: 10 pts Max  

• Laminar Compressibility Correction Derivation: 10 Points Max  

o Compressibility Correction 

o Average Boundary Layer Temperature 

• Inviscid L/D Plots and Supporting Analysis: 10 Points Max  

o Pressure Distributions vs Alpha 

o CL, CD vs Alpha 

o L/D Max Vs Mach Number 

• Viscous L/D Plot: 1/7th Power Law, Turbulent Skin Friction Only: 10 Points Max  

o CL, CD vs Alpha 

o L/D Max Vs Mach Number, Altitude 

• Transitional flow (laminar, transitional, and/or turbulent: 10 Points Max  

o L/D max vs Mach and Reynolds Number Plot 

o Transition Points Identified 

G. Example Figure 

 
Fig. 1 Magnetization as a function of applied fields. 

 
Line drawings must be clear and sharp. The must be large enough to be legible. Use of colors to highlight details 

is encouraged. Make sure that all lines and graph points are dark and distinct and that lettering is legible; 8- to 10-
point type is suitable for artwork that is sized to fit the column width (3 ¼ in.). Keep the lettering size and style 
uniform both within each figure and throughout all of your illustrations. Place figure captions below each figure, and 
limit caption length to 20-25 words. If your figure has multiple parts, include the labels “a),” “b),” etc., below and to 
the left of each part, above the figure caption. Please verify that the figures and tables you mention in the text 
actually exist. When citing a figure in the text, use the abbreviation “Fig.” except at the beginning of a sentence. 

Figures should have no background, borders, or outlines. In the electronic template, use the “Figure” style from 
the pull-down formatting menu to type caption text. You may also insert the caption by going to the Insert menu and 
choosing Caption. Make sure the label is “Fig.,” and type your caption text in the box provided. Captions are bold 
with a single tab (no hyphen or other character) between the figure number and figure description. 
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Use the Table drop-down menu to create your tables; See the Table 1 example for table style and column alignment. 
If you wish to center tables that do not fill the width of the page, simply highlight and “grab” the entire table to 
move it into proper position. 
 
 
 

H. Example Table 
 

Table 1 Transitions selected for thermometry 
 
 Transition   
Line n²  J² Frequency, cm-1 FJ, cm-1 Gn, cm-1 
a 0 P12 2.5 44069.416 73.58 948.66 
b 1 R2 2.5 42229.348 73.41 2824.76 
c 2 R21 805 40562.179 71.37 4672.68 
d 0 R2 23.5 42516.527 1045.85 948.76 

 

IV. Conclusion 

Although a conclusion may review the main points of the paper, it must not replicate the abstract. A conclusion 
might elaborate on the importance of the work or suggest applications and extensions. Do not cite references in the 
conclusion. Note that the conclusion section is the last section of the paper to be numbered. The appendix (if 
present), funding information, other acknowledgments, and references are listed without numbers. 

V. Bibliography 

I. Footnotes 
Footnotes, where they appear, are placed above the 1-in. margin at the bottom of the page. To insert footnotes 

into the template, use the Insert>Footnote feature from the main menu as necessary. Footnotes are formatted 
automatically in the template, but, if another medium is used, they should appear as superscript symbols in the 
following sequence: *, †, ‡, §, ¶, **, ††, ‡‡, §§, etc. 

List and number all references at the end of the paper. Corresponding bracketed numbers are used to cite 
references in the text [1], including citations that are an integral part of the sentence (e.g., “It is shown in Ref. [2] 
that…”) or follow a mathematical expression: “A2 + B = C (Ref. [3]).” For multiple citations, separate reference 
numbers with commas [4, 5], or use a dash to show a range [6–8]. Reference citations in the text should be in 
numerical order. 

 
J. References 

In the reference list, give all authors’ names; do not use “et al.” unless there are six authors or more. Papers that 
have not been published should be cited as “unpublished”; papers that have been submitted or accepted for 
publication should be cited as “submitted for publication.” Private communications and personal websites should 
appear as footnotes rather than in the reference list. 

References should be cited according to the standard publication reference style. (For examples, see the 
“References” section of this template.) Never edit titles in references to conform to AIAA style of spellings, 
abbreviations, etc. Names and locations of publishers should be listed; month and year should be included for 
reports and papers. For papers published in translation journals, please give the English citation first, followed by 
the original foreign language citation. 
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The examples below illustrate different reference types, following AIAA style. If you are using the Word version 
of this Template, select the “references” style from the drop-down style menu to format your references. All 
references should be in 9-point font, with reference numbers in brackets. You are not required to indicate the type of 
reference; different types are shown here for illustrative purposes only. 

The DOI (digital object identifier) should be incorporated in every reference for which it is available (see Ref. 1 
sample); for more information on DOIs, visit www.doi.org or www.crossref.org. 
Periodicals 
[1] Vatistas, G. H., Lin, S., and Kwok, C. K., “Reverse Flow Radius in Vortex Chambers,” AIAA Journal, Vol. 24, No. 11, 1986, 

pp. 1872, 1873. 
 doi: 10.2514/3.13046 
[2] Alyanak, E. J., and Pendleton, E., “Aeroelastic Tailoring and Active Aeroelastic Wing Impact on a Lambda Wing 

Configuration,” Journal of Aircraft, published online 10 Nov. 2016. 
 doi: 10.2514/1.C033040 
[3] Dornheim, M. A., “Planetary Flight Surge Faces Budget Realities,” Aviation Week and Space Technology, Vol. 145, No. 24, 

9 Dec. 1996, pp. 44–46. 
[4] Terster, W., “NASA Considers Switch to Delta 2,” Space News, Vol. 8, No. 2, 13–19 Jan. 1997, pp. 1, 18. 

All of the preceding information is required. The journal issue number (“No. 11” in Ref. 1) is preferred, but the 
month (Nov.) can be substituted if the issue number is not available. Use the complete date for daily and weekly 
publications. Transactions follow the same style as other journals. 
Books 
[5] Peyret, R., and Taylor, T. D., Computational Methods in Fluid Flow, 2nd ed., Springer-Verlag, New York, 1983, Chaps. 7, 

14. 
[6] Oates, G. C. (ed.), Aerothermodynamics of Gas Turbine and Rocket Propulsion, AIAA Education Series, AIAA, New York, 

1984, pp. 19, 136. 
[7] Volpe, R., “Techniques for Collision Prevention, Impact Stability, and Force Control by Space Manipulators,” Teleoperation 

and Robotics in Space, edited by S. B. Skaar and C. F. Ruoff, Progress in Astronautics and Aeronautics, AIAA, Washington, 
DC, 1994, pp. 175–212. 
Publisher, place, and date of publication are required for all books. No state or country is required for major 

cities: New York, London, Moscow, etc. A differentiation must always be made between Cambridge, MA, and 
Cambridge, England, UK. Note that series titles are in Roman type. 
Proceedings 
[8] Thompson, C. M., “Spacecraft Thermal Control, Design, and Operation,” AIAA Guidance, Navigation, and Control 

Conference, CP849, Vol. 1, AIAA, Washington, DC, 1989, pp. 103–115 
[9] Chi, Y. (ed.), Fluid Mechanics Proceedings, NASA SP-255, 1993. 
[10] Morris, J. D., “Convective Heat Transfer in Radially Rotating Ducts,” Proceedings of the Annual Heat Transfer Conference, 

edited by B. Corbell, Vol. 1, Inst. of Mechanical Engineering, New York, 1992, pp. 227–234. 
Reports, Theses, and Individual Papers 
[11]  Chapman, G. T., and Tobak, M., “Nonlinear Problems in Flight Dynamics,” NASA TM-85940, 1984. 
[12]  Brandis, A. M., Johnston, C. O., and Cruden, B. A., “Nonequilibrium Radiation for Earth Entry,” AIAA Paper 2016-3690, 

June 2016. 
[13] Steger, J. L., Jr., Nietubicz, C. J., and Heavey, J. E., “A General Curvilinear Grid Generation Program for Projectile 

Configurations,” U.S. Army Ballistic Research Lab., Rept. ARBRL-MR03142, Aberdeen Proving Ground, MD, Oct. 1981. 
[14] Tseng, K., “Nonlinear Green’s Function Method for Transonic Potential Flow,” Ph.D. Dissertation, Aeronautics and 

Astronautics Dept., Boston Univ., Cambridge, MA, 1983. 
Government agency reports do not require locations. For reports such as NASA TM-85940, neither insert nor 

delete dashes; leave them as provided. Place of publication should be given, although it is not mandatory, for 
military and company reports. Always include a city and state for universities. Papers need only the name of the 
sponsor; neither the sponsor’s location nor the conference name and location is required. Do not confuse 
proceedings references with conference papers. 
Electronic Publications 

Regularly issued electronic journals and other publications are permitted as references. Include the doi if 
provided; otherwise provide the full URL. Archived data sets also may be referenced as long as the material is 
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openly accessible and the repository is committed to archiving the data indefinitely. References to electronic data 
available only from personal websites or commercial, academic, or government ones where there is no commitment 
to archiving the data are not permitted in the reference list. 
 [15] Atkins, C. P., and Scantelbury, J. D., “The Activity Coefficient of Sodium Chloride in a Simulated Pore Solution 

Environment,” Journal of Corrosion Science and Engineering [online journal], Vol. 1, No. 1, Paper 2, URL: 
http://www.cp/umist.ac.uk/JCSE/vol1/vol1.html [retrieved 13 April 1998]. 

[16] Vickers, A., “10-110 mm/hr Hypodermic Gravity Design A,” Rainfall Simulation Database [online database], URL: 
http://www.geog.le.ac.uk/bgrg/lab.htm [retrieved 15 March 2006]. 

Break website addresses after punctuation, and do not hyphenate at line breaks. 
Computer Software 
[17] TAPP, Thermochemical and Physical Properties, Software Package, Ver. 1.0, E. S. Microware, Hamilton, OH, 1992. 

Include a version number and the company name and location of software packages. 
Patents 

Patents appear infrequently. Be sure to include the patent number and date. 
[18] Scherrer, R., Overholster, D., and Watson, K., Lockheed Corp., Burbank, CA, U.S. Patent Application for a “Vehicle,” 

Docket No. P-01-1532, filed 11 Feb. 1979. 
Private Communications and Websites 

References to private communications and personal website addresses are not permitted. They may, however, be 
incorporated into the main text of a manuscript or may appear in footnotes. 
Unpublished Papers and Books 

Unpublished works can be used as references as long as they are being considered for publication or can be 
located by the reader (such as papers that are part of an archival collection). If a journal paper or a book is being 
considered for publication, choose the format that reflects the status of the work (depending upon whether it has 
been accepted for publication): 
[19] Doe, J., “Title of Paper,” Name of Journal (to be published). 
[20] Doe, J., “Title of Chapter,” Name of Book, edited by…, Publisher’s name and location (to be published). 
[21] Doe, J., “Title of Work,” Name of Archive, Univ. (or organization), City, State, Year (unpublished). 

Unpublished works in an archive must include the name of the archive and the name and location of the 
university or other organization where the archive is held. Also include any cataloging information that may be 
provided. 


